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About this information product

Purpose

Reason for reissue

Safety labels

Intended audience

How to use this
information product

365-309-800
Issue 1, July 2001

This chapter is a preface that provides an overview of this information
product.

The purpose of this Administration Guide is to instruct users how to
administer WaveStar® Transport Management System (TMS) Release
1.0.

This Administration Guide, Issue 1, is a new document that supports a
new product, WaveStar TMS, Release 1.0.

This information product does not use safety labels.

This guide is written primarily for operations personnel who
administer WaveStar TMS.

This section provides information to help users of this information
product.

Lucent Technologies Xi
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Chapter descriptions

About this information product

The following table describes the information in each chapter of this

document.

Section

Preface

Chapter 1

Chapter 2

Chapter 3

Chapter 4

Chapter 5

Chapter 6

Chapter 7

Chapter 8

Chapter 9

Title

About this
information product

Chapter 1,
“Administration
overview”

Chapter 2, “Platform
Administration”

Chapter 3, “Security
M anagement”

Chapter 4, “System
administration”

Chapter 5,
“Provisioning
environment setup”

Chapter 6,
“Reliability and
service recovery ”

Chapter 7, “Off-line
Tool Concepts”

Chapter 8,
“Management
communication”

Chapter 9, “Trouble
clearing”

Description

Describes this document’s
purpose and intended
audience, how to use the
document, and how to
comment on it.

Provides an overview of
the administration process.

Contains platform-related
tasks that are performed on
HP servers.

Describes how to control
access to the WaveStar
TMS.

Describes how to perform
system administration
tasks.

Describes how to perform
intra-domain provisioning
and inter-domain
provisioning.

Provides instructions on
how to perform backups
and recover from system
failures.

Describes the off-line
tools.

Includes database
synchronization and LAN
status tasks.

Contains trouble clearing
tasks.

Lucent Technologies

365-309-800
Issue 1, July 2001



Administration Guide

Section
Chapter 10

Appendix

I ndex

Title

Chapter 10, “Patch
and Software
Upgrade Tasks’

Appendix A,
“Installation
Parameters’

Index

About this information product

Description

Describes how to install a
patch for WaveStar TMS.

Describes the WaveStar
TMS system parameters.

Enables the user to quickly
find information on
specific topics.

Conventions used  This document uses the following typographical conventions to
distinguish between computer input and output.

*  When describing the WaveStar TM S software, fields in windows
and field entries are identified with this font.

«  When describing the UNIX™ environment, text and numbers that
the user inputs to the computer are identified with boldface

type.

* Inthe UNIX environment, text and numbers that the computer
outputs to the user are identified with monospace type.

Related documentation  This information product is part of a set of documents that supports

WaveStar TMS.

List of documents

The document set that supports WaveStar TMS includes:

1. WaveSar TMS Administration Guide, (365-309-800) - instructs
users on how to administer WaveStar TMS and the network.
This document includes tasks and conceptual information.

2. WaveSar TMS Provisioning Guide, (365-309-801) - instructs
users how to use WaveStar TMS to provision and manage a

network.

This document includes tasks and conceptual information.

On-line documentation

An on-line HTML version of theWaveStar TMS document set is
integrated into the product software.

365-309-800 Lucent Technologies
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How to comment

About this information product

Screen help

This release of WaveStar TMS does not include screen help for each
window.

Additional documents

The document set that supports WaveStar Network Management
System (NMS) also provides valuable information for the users of
WaveStar TMS. The document set that supports WaveStar NM S
includes:

1. WaveStar NMS Getting Started Guide, (365-309-240) - provides
information needed when you are learning how to use the
WaveStar NM S software. It describes how to start and stop
WaveStar NMS, how to use the software, and how to interpret
the graphical user interface.

This document includes tasks and conceptual information.

2. WaveSar NMS Applications and Planning Guide, (365-309-236)
- describes the WaveStar NM S features and applications, provides
a product description and the hardware platforms for the product,
and describes system planning and engineering, ordering, and
product support.
This document contains conceptua information only.

3. WaveSar NMS Administration Guide, (365-309-239) - instructs
users on how to administer WaveStar NMS and the network.
This document includes tasks and conceptual information.

4. WaveSar NMS Maintenance Guide, (365-309-238) - instructs
users on how to maintain WaveStar NMS and the network.
This document includes tasks and conceptual information.

5. WaveStar NMS Provisioning Guide, (365-309-237) - instructs
users how to use WaveStar NMS to provision and manage a
network.

This document includes tasks and conceptual information.

Glossary

The WaveStar NMS Administration Guide contains a glossary that will
be helpful to users of WaveStar TMS.

Customer satisfaction is extremely important to Lucent Technologies.
All users are encouraged to provide feedback on the WaveStar TMS
information products.

Lucent Technologies 365-309-800
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A customer comment form appears immediately after the title page of
this document. Please fill out the form and submit is as instructed on
the form.

How to order  To order WaveStar TMS information products, contact your Lucent
Technologies customer team representative or contact the Lucent
Technologies Customer Information Center (CIC):

*  From the United States, call 1-888-LUCENTS, prompt 1.
*  From Canada, call 1-317-322-6619.
From Europe, the Middle East, and Africa, call 1-317-322-6416.

From Asia, the Pacific Region, China, the Caribbean, and Latin
America, call 1-317-322-6411.
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1 Administration overview

Overview

Purpose  This chapter provides an overview of the WaveStar Transport
Management System (TMS) administration process.

Important Note  This document covers the administrative operations on WaveStar
TMS.
In order to do so, this document contains two types of chapters:

o  Task chapters describe administration tasks (that is, step-by-step
instructions).

*  Conceptual chapters contain detailed information related to the
tasks.

Task chapters are located in the front of the document; conceptual
chapters follow the task chapters.

Contents
What is administration? 1-2
Who performs administration tasks? 1-4
Supported hardware configuration 1-5
WaveStar TMS file systems 1-6
Run levels 1-7
L]
365-309-800 Lucent Technologies 1-1
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What i1s administration?

Introduction

Platform support

Security management
support

System administration
support

Provisioning support

Reliability and service
recovery support

Off-line tools support

Management
communication support

Trouble clearing support

The administration process provides the following type of support to
WaveStar TMS and the network:

*  Platform support

e Security management support

e System administration support

*  Provisioning support

* Rdiability and service recovery

e Off-line tools support

*  Management communication support
*  Trouble clearing support

*  Patch and software upgrade support

Platform support includes tasks associated with HP servers.

Security management support includes tasks associated with how to
add and delete user 1Ds and profiles.

System administration support includes tasks associated with
administering the WaveStar TM S application.

Provisioning support includes tasks used to initialize the TMS
database with digital links and circuits. This includes provisioning
inter-domain digital links and inter- and intra-domain circuits.

Reliability and service recovery support includes system-related tasks,
such as how to backup or recover the system.

Off-line tools support includes a description on how to use WaveStar
TMS off-line scripts.

Management communication support includes database
synchronization and LAN status tasks.

Trouble clearing support includes tasks associated with creating trace
files and with viewing core, log, and console.log files.

365-309-800
Issue 1, July 2001
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Patch and software  The Patch and software upgrade support chapter will include
upgrade support  information on how to install a WaveStar TMS patch.

365-309-800 Lucent Technologies 1-3
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Who performs administration tasks?

Introduction

System administrator user
types

Functions

Administrative tasks are performed by users with system administrator
permissions.

There are several administrator user types available which define the
operating systems and platforms to which a system administrator may
access. These user type levels include:

Operating System (OS) Superuser, or the highest, privileged user,
for example, root on UNIX or Administrator on Windows.

OS Administrator, which is created by the OS Superuser. This
user type is typically configured with access to specific OS
administrator-level tools and system-packaged tools.

OS User, which may be created or deleted by the OS Superuser
or OS Administrator user.

This user type may typicaly use standard OS tools, such as
UNIX vi, configured with access to OS admin and
system-specific tools.

System Administrator, a user type which performs day-to-day
tasks using system administrative tools. Typicaly the System
Administrator user also has OS User privileges.

Users with system administrator privileges are able to perform tasks
that enable them to:

Provide security management, provisioning, and system support
to the WaveStar TMS host and to the Network Map

Control the appearance of the Network Map

Lucent Technologies 365-309-800
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Supported hardware configuration

Hardware configuration = WaveStar TMS only supports a single server with disk mirroring
configuration. The tasks within this guide pertain to the supported
configuration only.

365-309-800 Lucent Technologies 1-5
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WaveStar TMS file systems

Introduction  WaveStar TMS has 17 file systems.

List of file systems  The following lists the directory structure supported within WaveStar
TMS.

N o a bk w bR

10.

11.
12.
13.
14.
15.
16.
17.

Root directory ( /)

OS kernel ( /stand)

Spool directories ( /var)

Core OS components ( /usr)

Optional OS components ( /opt)

Provisioning documents directory ( /dacscan/prov)

Alarms directory ( /dacscan/alarms). Note that this directory
applies to host alerts; Fault Management is not supported on
TMS.

Three Oracle tablespace directories ( /oradb, /oradb2,
/oradb3)

Application logs directory ( /dacscan/log)

Database re-do logs and archives directory ( /dacscan/dbarch
and /dacscan/journal)

Application users directory ( /dacscan/users)
Application trace information directory ( /dacscan/trace)
Temporary directory ( /tmp)

Application temporary space ( /dacscan/tmp)
Application software ( /usr/dacscan)

Application software patch history ( /patch)

Q-adapter ( /ITM-QA).

1-6 Lucent Technologies 365-309-800
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Run levels
Introduction  Certain tasks in this guide require the system administrator to change
the run level of the WaveStar TMS application on an HP-UX
machine. The following describes two run levels, run level 3 and run
level 4.

Run level 3 When the system administrator enters the init 3 command on an
HP-UX machine, this causes the system is set to run level 3 which
shuts down the WaveStar TM S application.

Run level 4  When the system administrator enters the init 4 command on an
HP-UX machine, this causes the system is set to run level 4 which
starts up the WaveStar TMS application.

365-309-800 Lucent Technologies 1-7
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2 Platform Administration

Overview
Purpose  This chapter contains information on how to:
*  power on HP servers
e manage users on machines running on HP-UX and Windows
platforms

»  create and delete SAGE workstation users

e add a printer

e power down HP servers

Contents
Section |: Powering on the HP server 2-3
Power on HP server (single server configuration 2-4
with mirrored disks)
Section I1: Administering users 2-5
Add a user on an HP-UX server through System 2-6
Administration (sam)
Add a user to a Windows PC and assign user 2-9
privileges
Add a user to a Windows PC and assign System 2-11
Administrator (SA) privileges
365-309-800 Lucent Technologies 2-1
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Overview

Section I11: Administer SAGE Desktop
I ntegration users

Section |V: Add printers

Add a network printer

Add a local serial printer

Set up the Common Desktop Environment (CDE)
printer icon

Section V: Miscellaneous management
communication tasks

View LAN status information

Section VI: Powering off an HP server

Platform Administration
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Section |: Powering on the HP server

Overview
Purpose  This section describes how to power on the HP server.
Contents
Power on HP server (single server configuration 2-4
with mirrored disks)
[
365-309-800 Lucent Technologies 2-3
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Section I: Powering on the HP server Platform Administration

Power on HP server (single server configuration with mirrored

disks)

Purpose

Task

Use this procedure to power on the HP server using the single server
with mirrored disks configuration.

Important! When the system is powered on, it automatically starts the
WaveStar TM'S application.

Use this procedure to power on the HP server using the single
server with mirrored disks configuration.

Press the power switch (or turn key, as appropriate) to the HP 9000
host processor.

Result:

The HP server runs diagnostics and proceeds into multi-user
mode. During the start-up, the user is questioned about the
system date. Answer the questions, as appropriate. The system is
ready when the Console Login prompt appears.

Enter the command init 4 to bring the application up to run level 4.
END OF STEPS

O

Lucent Technologies 365-309-800
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Section I1: Administering users

Overview
Purpose  This section contains tasks to create users on HP servers, Windows
PCs, and SAGE workstations.
Contents
Add a user on an HP-UX server through System 2-6
Administration (sam)
Add a user to a Windows PC and assign user 2-9
privileges
Add a user to a Windows PC and assign System -11
Administrator (SA) privileges
]
365-309-800 Lucent Technologies 2-5
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Section Il: Administering users

Platform Administration

Add a user on an HP-UX server through System Administration

Purpose

Before you begin

Task

Use this procedure to add a user through the sam application on an
HP server.

Before you begin this task:
e Confirm that a dacscan login exists on the server.

e Confirm that the WaveStar TMS and the Domain Management
System (DMS) host nhames exist in the .rhosts file under the
dacscan login's home directory.

Perform the steps below to add a user through the sam
application on an HP server.

On the HP VUE panel (at the bottom of the screen), select the
terminal icon to open an hpterm window.

Result:

An hpterm window displays.
At the prompt, enter sam and then press Enter.

Result:

A menu of System Administration options is displayed.
Double click the Accounts for Users and Groups icon.

Result:

A menu of User and Group options is displayed.
Double click the Users icon.

Result:

A User Management form is displayed.

Lucent Technologies 365-309-800
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Section |l: Administering users

Platform Administration

Add a user on an HP-UX server through
System Administration (sam)

6 Select the Add function.
Result:
The Add a User Account form displays.

7 Inthe Login Name field, enter a value of up to 8 characters
representing the 1D (such as the person’s abbreviated name) and press
Enter.

Important! The valid characters allowed in the ID are lowercase
letters (a-z), numbers (0-9), and one or more underscores (). The first
character must be a lowercase letter. The underscores may be in any
position after the first.

8 At the Home directory field, which is pre-populated with home
directory data such as /nome/<userID>, check the Create Home
Directory field and press Enter.

Important! The Create Home Directory box must be checked in
order to successfully add the user.

9 Inthe Primary Group Name field, enter dba and press Enter.

10 Inthe Start-up Program field, enter /usr/bin/ksh and press
Enter.
Important! The remaining information is optional.
11  Click OK to continue.
Result:
A password prompt is displayed.
12  Enter and re-enter a password.
13  Exit sam
365-309-800 Lucent Technologies 2-7
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Section Il: Administering users Platform Administration
Add a user on an HP-UX server through
System Administration (sam)

14  Log off from the server.
END OF STEPS

2-8 Lucent Technologies 365-309-800
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Add a user to a Windows PC and assign user privileges

Purpose  Use this procedure to add a user to a Windows PC and assign user
privileges.

Before you begin  Be sure that the user 1D has been created.

Permissions  You must have system administrator privileges on the PC in order to
perform this task.

Task Perform the steps below to add a user to a Windows PC and
assign user privileges.

1 On the Windows main window, click on the Start button in the task
bar.

Result:
A menu is displayed.

2 Select Programs > Administrative Tools (Common) > User
Manager.

Result:
The User Manager window is displayed.
3 From the User Manager window, select New User.
Result:
The New User window is displayed.

4  Complete the required Username field and the optional Full Name
and Description fields.

5 Inthe Password field, enter the password associated with the new
user ID.

365-309-800 Lucent Technologies 2-9
Issue 1, July 2001



Section Il: Administering users Platform Administration
Add a user to a Windows PC and assign
user privileges

9 Select the Groups button.
Result:
The Group Membership screen is displayed.

10 On the Group Membership screen, view the Member of list for a
Users entry. If Users is not listed, highlight Users in the Not
Member of list and select the Add button.

Important! If an entry other than Users displays in the Member of
list, highlight the entry, then select the Remove button to move the
entry to the Not Member of list.

Result:
Users displays in the Member of list.
11  On the Group Membership screen, select OK.
Result:
The Group Membership screen closes.
12 On the New User screen, select OK.
Result:

The New User screen closes and the new user is listed on the
User Manager screen.
END OF STEPS
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Section |l: Administering users

Platform Administration

Add a user to a Windows PC and assign System Administrator

(SA) privileges

Purpose

Before you begin
Permissions

Tasks

365-309-800
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Use this procedure to add a user to a Windows PC and assign system
administrator privileges.

Be sure that the user ID has been created.
You must be authorized to perform this task.

Perform the steps below to create a system administrator login
and assign system administrator privileges on a Windows PC.

On the Windows main window, click on the Start button in the task
bar.

Result:
A menu is displayed.

Select Programs > Administrative Tools (Common) > User
Manager.

Result:

The User Manager window is displayed.
From the User Manager window, select New User.

Result:

The New User window is displayed.

Complete the required Username field and the optional Full Name
and Description fields.

In the Password field, enter the password associated with the new
user ID.
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Section Il: Administering users Platform Administration
Add a user to a Windows PC and assign
System Administrator (SA) privileges

7 Uncheck User Must Change Password at Next Logon.

9 Select the Groups button.
Result:
The Group Membership screen is displayed.

10 Onthe Group Membership screen, view the Member of list for an
Administrators entry. If Administrators is not listed, highlight
Administrators in the Not Member of list and select the Add
button.

Important! If an entry other than Administrators displays in the
Member of list, highlight the entry then select the Remove button
to move the entry to the Not Member of list.

Result:
Administrators displays in the Member of list.
11  On the Group Membership screen, select OK.
Result:
The Group Membership screen closes.
12 On the New User screen, select OK.
Result:

The New User screen closes and the new user is listed on the
User Manager screen.
END OF STEPS
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Platform Administration

Section I11: Administer SAGE Desktop Integration users

Overview
Purpose  This section describes how to administer the Secure Access Gateway
for Enterprises (SAGE) Desktop Integration feature.
L]
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Section Il1: Administer SAGE Desktop Platform Administration
Integration users

Definition: SAGE Desktop Integration

SAGE Desktop

Related information

SAGE Desktop Integration is an optional feature for WaveStar TMS
applications that allows users to access multiple WaveStar TMS
systems through a web browser.

A system administrator may add or delete SAGE users to/from an
HP-UX client workstation.

Since SAGE requires each user to have an individua profile, the
system administrator needs to manage these, along with user logins
and passwords. The administrator also needs to support users with
how to log into SAGE, how to change passwords, how to modify user
attributes, and how to interpret and respond to system messages.

For more detailed system administration instructions, see the Secure
Access Gateway for Enterprises (SAGE) Manual.

O
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Section Il1: Administer SAGE Desktop Platform Administration

Integration users

Add a user to a SAGE workstation

Purpose

Task

Use this procedure to add a user to a SAGE workstation.

Perform the steps below to add a user to a SAGE client
workstation.

Click on the IWS icon.

Result:

The IWS HOME PAGE form is displayed.
Click on the TMS Network Module icon.

Result:

The TMS Network Module form is displayed.
Select Administration>Security Assignments.

Result:

The Controller: Security Privilege Query Box #1 form is
displayed.

Select Action, and Add User to Work Group.

Result:

The Add User to Work Group form is displayed.
Type the user ID in the User ID field and click OK.

Important! If a specific geographic domain is required for the new
User ID, refer to Chapter 5, “Provisioning environment setup” in this
document.

365-309-800
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Section Il1: Administer SAGE Desktop Platform Administration
Integration users
Add a user to a SAGE workstation

Result:
The user ID is added to the SAGE workstation.

END OF STEPS
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Section Il1: Administer SAGE Desktop Platform Administration

Integration users

Delete a user from a SAGE workstation

Purpose

Task

Use this procedure to delete a user from a SAGE workstation.

Perform the steps below to delete a user from a SAGE
workstation.

Log into the SAGE workstation as system administrator then bring up
the WaveStar TM'S map.

Select Administration>Security Assignments.

Result:

The Controller: Security Privilege Query Box #1 form is
displayed.

Select the user ID to be deleted then select Action and Delete User.
Result:
The selected user ID is deleted from the workstation.

END OF STEPS

365-309-800
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Platform Administration

Section IV: Add printers

Overview
Purpose  This section describes how to add a printer.
Contents
Add a network printer 2-19
Add a local serial printer 2-21
Set up the Common Desktop Environment (CDE) 2-22
printer icon
]
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Section 1V: Add printers

Platform Administration

Add a network printer

Purpose

Before you begin

Use this procedure to add a network printer to the workstation.

Before you begin this task, collect the following information:
e  Printer name (the printer name must be six characters or less)
 IPAddress

The network printer must be connected to Ethernet. The local serial
printer must be connected to the asynchronous mux board.

Task Perform the steps below to add a network printer.
1  Take the printer off-line.
2  Press the Menu button until TEST MENU appears in the display.
3 Pressthe Item button until SELF TEST appears in the display.
4  Press Enter.
Result:
A printer status sheet prints. This status sheet indicates the LAN
hardware address (LAN HW ADDRESS), network peripheral
name (HOST NAME), and the IP address, if these values have
been assigned to the printer.
5 PressOn Line.
6 Using the system console, log in as root on the primary host via the
system console.
7 Enter ksh Zinstall/prtinstall at the # prompt.
Important! For a serial printer, the script is ksh
/install/serial_prt
365-309-800 Lucent Technologies 2-19
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Section IV: Add printers Platform Administration
Add a network printer

8 Answer the questions as appropriate.
Result:
The network printer is added.

END OF STEPS

2-20 Lucent Technologies 365-309-800
Issue 1, July 2001



Section 1V: Add printers

Platform Administration

Add a local serial printer

Purpose

Before you begin

Task

365-309-800
Issue 1, July 2001

Use this procedure to add a local serial printer.

Before you begin this task, collect the following information:
*  Printer name (the printer name must be six characters or less)

Perform the steps below to add a local serial printer to your
workstation.

Answer the questions as appropriate.

Result:
The local seria printer is added.

END OF STEPS
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Section 1V: Add printers

Platform Administration

Set up the Common Desktop Environment (CDE) printer icon

Purpose

Task

10

Use this procedure to configure the workstation to print WaveStar
TMS forms to a local printer.

The workstation can be configured to enable the CDE printer icon to
be used to print WaveStar TMS forms to a local printer.

Perform the steps below to set up the CDE printer icon.

Log in as root.

Enter cd /config at the UNIX prompt.

Enter vi sys.vuewmrc

Change the PUSH_ACTION variable in the “CONTROL Printer”
section to PUSH_ACTION f.action PrintPush

Save the file.

Exit the file.

Enter cd /usr/vue/config/types

Enter vi PrintPush.vf

Change the EXEC-STRING variable in the “Action PrintPush” section
to EXEC-STRING bin/ksh -c “xwd -frame | xpr -device
ps -cutoff 70 -rv | Ip -0 nb -0 postscript’

Save the file.

Exit the file.
Lucent Technologies 365-309-800
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Section IV: Add printers Platform Administration
Set up the Common Desktop Environment
(CDE) printer icon

12  Sedlect Exit on the HP Vue to reboot the workstation.
END OF STEPS
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Platform Administration

Section V: Miscellaneous management communication tasks

Overview
Purpose  This section describes miscellaneous management communication
tasks.
Contents
View LAN status information 2-25
L]
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Section V: Miscellaneous management Platform Administration
communication tasks

View LAN status information

Purpose Use this procedure to view the status of any of the LANSs that are
connected to the machine, including the LAN that connects the
WaveStar TMS to the DMS.

Task  Perform the steps below to view LAN status information.

2 Enter lanscan

Result:
The LAN status information is displayed.

END OF STEPS

365-309-800 Lucent Technologies 2-25
Issue 1, July 2001



Platform Administration

Section VI: Powering off an HP server

Overview

Purpose  This section describes how to power off an HP server.
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Section VI: Powering off an HP server Platform Administration

Shut down the WaveStar TMS application

Purpose

Task

365-309-800
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Use the following procedure to shut down the WaveStar TMS
application.

Complete the following task to shut down the WaveStar TMS
application.

Enter init 3 to bring the application down to run level 3.
Result:

The system(s) eventually issue a message to indicate that
WaveStar TMS has been shut down.

Power off all external disk drives.
Result:

The HP workstation is powered off.
END OF STEPS
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Section VI: Powering off an HP server Platform Administration

Power off an HP server

Purpose  Use the following procedure to power off an HP server.
Task  Complete the following task to power off an HP server.
1 “Shut down the WaveStar TMS application” (2-27).
2  Log into the host system as root.
3 At the # prompt, enter shutdown -h -y 0
Result:
The server eventually issues a message that indicates that it is
safe to power down the server.
4  Power off the HP workstation.
5 Power off the Host Console Terminal.
6 Power off all external disk drives.
Result:
The HP workstation is powered off.
END OF STEPS
O
2-28 Lucent Technologies 365-309-800

Issue 1, July 2001



Lucent Technologies
Bell Labs Innovations

3 Security Management

Overview

Purpose  This section describes how to administer users and user profiles in
WaveStar TMS.

This chapter describes tasks performed to restrict access to WaveStar
TMS, the network elements, and the WaveStar NM S capabilities.

Background  Administrators are responsible for adding, modifying, and deleting
WaveStar TMS user IDs. They also define the tasks to which users
may or may not access by assigning a user profile to a user ID.

Contents
Add a user 3-2
Modify a user 34
Delete a user 3-6_
Add a user profile 3-7
Modify a user profile 3-8
Delete a user profile 39
]
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Add a user

Purpose

Permissions

Task

Security Management

Use this procedure to add a user to WaveStar TMS.

You must be authorized to perform this task.

Important! Before you perform this task, the user ID must first be
added to the specific platform. See Chapter 2, “Platform
Administration” for details.

Complete the following steps to add a user to WaveStar TMS.

On the Network Map, select Administration > Security
Assignments > Users > Add.

Result:
The Add User form appears.

In the Description field (if desired, this field is optional), enter a
description to be associated with the user ID.

In the Profile field, select a user profile from the drop-down list.

The values are:

* Default Profile

e Initial

* Provisioning (View Only)
* Combined

If no user profile is selected, the user is automatically assigned Initial
profile.

Result:

The selected profile is displayed and the tasks associated with
the profile selection are displayed in the Assigned Tasks area
of the window.

Lucent Technologies 365-309-800
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Add a user Security Management

6 Click Apply.
Result:

A message displays at the bottom of the Add User form
indicating that the user is added.

7 Click OK.
Result:

The Add User form closes.
END OF STEPS
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Modify a user

Purpose

Permissions

Task

Security Management

Use this procedure to modify user ID information.
You must be authorized to perform this task.

Complete the following steps to modify a user:

On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form appears.

From the Actions menu, select Modify User.
Result:
The Modify User form appears.

Change the Description, Profile, or User Type parameters as
desired.

Click Apply.
Result:

A message displays at the bottom of the Modify User form
which states that the parameters for the selected user are
modified.

Result:

Lucent Technologies 365-309-800
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Modify a user Security Management

Result:

The List of Users form closes.
END OF STEPS
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Delete a user

Purpose

Permissions

Security Management

Use this procedure to delete a regular user.
You must be authorized to perform this task.

Complete the following steps to delete a user:

On the Network Map, select Administration > Security
Assignments > Users > Display/Modify.

Result:

The List of Users form appears.

From the Actions menu, select Delete User.
Result:

A confirmation box appears and asks if you really want to delete
this user.

Click Yes.
Result:
The user ID is deleted.
Select File > Close.
Result:

The List of Users form closes.
END OF STEPS
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Add a user profile

Purpose

Permissions

Task

365-309-800
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Security Management

Use this procedure to add a user profile.
You must be authorized to perform this task.

Complete the following steps to add a user profile:

On the Network Map, select Administration > Security
Assignments > Profiles > Add Profile.

Result:
The Add Profile form is displayed.

In the Profile Name field, enter a name for the user profile (up to 30
characters).

Add tasks to the user profile by moving them from the Available
Tasks list to the Selected Tasks list.

Click Apply.
Result:

The user profile is added and is now available for assignment to
USErsS.

Click OK.
Result:

The Add Profile form closes.
END OF STEPS
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Security Management

Modify a user profile

Purpose

Permissions

Task

Use this procedure to modify a user profile.
You must be authorized to perform this task.

Complete the following steps to modify a user profile:

On the Network Map, select Administration > Security
Assignments > Profiles > Modify Profile.

Result:
The Modify Profile form appears.

In the Profile Name field, select the user profile to be modified from
the drop-down list.

Result:

The selected and available tasks for the user profile are
displayed.
Do one of the following:

e Add tasks to the user profile by moving them from the
Available Tasks list to the Selected Tasks list.

*  Remove tasks from the user profile by moving them from the
Selected Tasks list to the Available Tasks list.

Click Apply.

Result:

The user profile is modified.
Click OK.

Result:

The Modify Profile form closes.
END OF STEPS
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Security Management

Delete a user profile

Purpose

Permissions

Task

365-309-800
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Use this procedure to delete a user profile.
You must be authorized to perform this task.

Complete the following steps to delete a user profile:

On the Network Map, select Administration > Security
Assignments> Profiles > Delete Profile.

Result:
The Delete Profile form appears.

In the Profile Name field, select the name of the user profile to be
deleted from the drop-down list.

Click Apply.
Result:

A confirmation box appears and asks if you really want to delete
this profile.

Click Yes.

Result:

The user profile is deleted.
Click Close.

Result:

The Delete Profile form closes.
END OF STEPS
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4 System administration

Overview

Purpose

Contents

This chapter describes tasks performed to administer WaveStar TMS.

Section |: Start WaveStar TMS
Start WaveStar TMS on a PC
Section |1: Stop WaveStar TMS
Stop WaveStar TM S

Shut down WaveStar TM S with UPS

Section |11: Administer the system cron file

View the system cron file

Edit the system cron file

Section 1V: Restart and stop the Oracle database
Restart the Oracle database
Stop the Oracle database

Section V: Monitor space
Section VI: Network Map System Administration
Install a new background map for all users

Install a new background map for users of Windows
PC client machines
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Overview

Update a network element position

Add a user defined submap

Display/modify a user defined submap

Delete a user defined submap

Section VII: Set Preferences

Set map preferences

Section VIII: Miscellaneous system
administration

Search for location-type information for a specific
network element

Search for controlled network elements

Display the software version number

Display patch information

System administration
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System administration

Section |: Start WaveStar TMS

Overview

Purpose

Background

Start the host application

Contents

365-309-800
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This section describes how to start WaveStar TMS.

The initial step to start WaveStar TMS is to power up the
Hewlett-Packard processor. There are a few possible configurations
users can have with the processor, but the configurations fall into two
main categories — duplex and simplex (standalone). Within simplex,
the configuration may or may not contain mirrored disks.

When the system is powered up, it automatically proceeds to start the
WaveStar TMS application.

The Host application starts when the HP 9000 Processor is brought to
run level 4, and stops when the HP 9000 Processor is brought to run
level 3 (multi-user mode).

Start WaveStar TMS on a PC

H
N
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Section |: Start WaveStar TMS System administration

Start WaveStar TMS on a PC

Purpose  Use this procedure to start the WaveStar TMS on a PC.

Before you begin  Before running WaveStar TMS on a PC, the WaveStar TMS
application must be loaded on the PC. This task assumes that the
application has been already |oaded.

Task Complete the following steps to start WaveStar TMS on a PC.

IF... THEN...

The WaveStar TMS icon Go to Step 5.
displays on the desktop:

The WaveStar TMS icon Go to the next step.
does not display on the
desktop:

3  Click the Start button in the taskbar, then select Programs>
Windows (NT) Explorer.

Result:
The Windows Explorer window displays.

4  Navigate to the c:\jui\bin directory (or an aternate directory)
containing the run_jnm.bat file.

Result:
The filesin the c:\jui\bin directory display.
5 Continue with one of the following.
*  On the desktop, double-click the icon.
* In Windows Explorer, double-click the run_jnm.bat file.
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Section |: Start WaveStar TMS System administration
Start WaveStar TMS on a PC

Result:
The WaveStar TMS Network Map appears.

END OF STEPS
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System administration

Section Il: Stop WaveStar TMS

Overview

Purpose  This section describes how to stop WaveStar TMS.

Stop the host application  The Host application starts when the HP 9000 Processor is brought to
run level 4, and stops when the HP 9000 Processor is brought to run
level 3 (multi-user mode).

Under certain circumstances it may be required to bring the HP 9000
Processor to run level. 3. For example, if the system needs a new
software load.

Contents
Stop WaveStar TMS 4-7
Shut down WaveStar TM S with UPS 4-8
]
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Section |l: Stop WaveStar TMS System administration

Stop WaveStar TMS

Purpose  Use this procedure to stop the WaveStar TMS application.

Task  Complete the following task to stop the WaveStar TMS
application.

1 On the Network Map, do one of the following:
Select File > Exit.
»  Select the close button in the top right corner of the Network
Map.
Result:

A confirmation dialog box appears.

Result:
The WaveStar TM 'S session ends.

END OF STEPS

365-309-800 Lucent Technologies 4-7
Issue 1, July 2001



Section Il: Stop WaveStar TMS

System administration

Shut down WaveStar TMS with UPS

Introduction

Configurable file

Task

An Uninterruptible Power Supply (UPS) protects against power
failures. It is used to protect the main servers and their essential
peripherals from minutes of power failure. In the case of alonger
power loss, the UPS enables the system to shut down gracefully.

The UPS provides a configurable file that contains two timers used in
the shutdown. When the WaveStar TM S application receives
notification to indicate a loss of AC power, the application runs a
shutdown script that results in a graceful shutdown of the application
within the time limit of these timers:

e shutdown delay mins: This parameter indicates the number of
minutes following notification that its UPS has switched to
internal battery power before the UPS monitor initiates a
shutdown. The default value for this parameter is one minute.

e shutdown_timeout_mins. This parameter indicates the number of
minutes to monitor the shutdown operation before a reboot is
initiated with the halt option. The default value for this parameter
is five minutes.

These timers are tunable at time of installation and can be changed
subsequent to installation; however, normally they should not need to
be changed.

Systems configured with UPS are brought into init level 4
automatically on power up.

Use local procedures to support your UPS hardware.
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System administration

Section III: Administer the system cron file

Overview

Purpose

Background

File format

Contents

This section describes how to administer the system cron file.

The cron file contains commands that are automatically executed at
set times.

Certain commands can be executed at desired times by using the
system cron. The root cron and dacscan cron operate independently.
The root cron has various administrative functions that are executed
on a routine basis, such as daily backups and file system space
monitoring. The dacscan cron has various application-related
functions, such as database syncs and auto-implementation.

The read-only root cron file format is such that everything on the
active line is separated by blanks or tabs. Each field of the active line
correlates to a subset of time. The following is an example of an
active line, with each field separated by a tab (indicated by -->):

min-->hour-->day-->month-->day-of-week-->command
min: 0-59 hour: 0-23 day:1-31 month:1-12 day of
week: 0-6 (Sunday=0) command: program to be executed

In place of numerics, an asterisk (*) may be used to imply the whole
range (wild card). A sample active line may look like:

01 04,23 * * * ksh /usr/dacscan/bin/auto_backup &

This line implies that the auto_backup will execute in the background
one minute past the 4th hour and, again, one minute past the 23rd
hour, every day, every month and every day of the week.

The cron files can be edited. Once the file is created/edited, it must be
loaded into the cron.

AR
=
o

View the system cron file

.l}
[BEN
[EEN

Edit the system cron file
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Section I11: Administer the system cron file System administration

View the system cron file

Purpose

Task

Use this procedure to view the system cron file.

Important! The system cron file is a read-only file. It can only be
edited by the superuser (root user).

Perform the steps below to view the system cron file.

Press Enter.
Result:

The root cron file is displayed.

END OF STEPS
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Section I11: Administer the system cron file System administration

Edit the system cron file

Purpose

Task

365-309-800
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Use this procedure to change the desired execution times of
commands in the system cron file.
Important! The system cron file can only be edited by the superuser
(root user).
Perform the steps below to edit the system cron file.
Using the system console, log into the primary host as root.
Enter cd /usr/spool/cron/crontabs <CR> at the # prompt.
Enter Is -1 <Enter> at the # prompt.
Result:
The files root and dacscan are listed.
Edit the desired parameter
IF... THEN...
The root file is being Log in as root and enter crontab
edited. root <Enter> at the # prompt.
Result:
The root file is read into the system
cron.
The dacscan file is being Log in as dacscan and enter crontab
edited. dacscan <Enter> at the # prompt.
Result:
The dacscan file is read into the
system cron.
END OF STEPS
L]
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System administration

Section 1V: Restart and stop the Oracle database

Overview

Purpose  This section describes how to restart and stop the Oracle database.

Definition: Oracle database  The Oracle database is used to retain persistent copies of application
and customer data. Use of Oracle's Transaction Processing Option
enables concurrency control and a high degree of data integrity.

Important  Starting and stopping the database should be performed only at the
direction of Lucent Customer Support.

Contents
Restart the Oracle database 4-13
Stop the Oracle database 4-14
OJ
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Section IV: Restart and stop the Oracle System administration
database

Restart the Oracle database

Purpose Use this procedure to restart the Oracle database.

Important! This procedure is only performed at the direction of
Lucent Customer Support.

Task  Perform the steps below to restart the Oracle database.

2 Enter /usr/dacscan/toolbin/startdb.sh at the prompt.
Result:

A message is displayed on the form to indicate that the database
has been started.
END OF STEPS
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Section 1V: Restart and stop the Oracle System administration
database

Stop the Oracle database

Purpose Use this procedure to stop the Oracle database.

Task  Perform the steps below to stop the Oracle database.

2  Stop the application on the host.
Reference:

For instructions, see the “ Shut down the WaveStar TM'S
application” (2-27) task in Chapter 2, “Platform Administration”.

3 Enter Zusr/dacscan/toolbin/shutdb.sh at the prompt.
Result:

A message is displayed on the form which indicates that the
database has been stopped.

END OF STEPS
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System administration

Section V: Monitor space

Overview
Purpose WaveStar TMS has an internal script that periodically checks its own
filesystems to verify that they are not running out of space. The
following describes WaveStar TMS's space monitoring and recovery
program.
O
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Section V: Monitor space

Monitor space

Definition: Spacewatch
program

Warning messages

Recovery messages

System administration

Spacewatch is a space monitoring and recovery program that provides
file-system monitoring once per hour for the following controller files:

*  Provisioning documents directory (/dacscan/prov)

e Alarms directory (/dacscan/alarms)

* Application logs directory (/dacscan/log)

»  Database archives directory (/dacscan/dbarch)

*  Application users directory (/dacscan/users)

*  Application trace information directory (/dacscan/trace)

If a controller file is over 60% full, Spacewatch provides a warning
message to the system event log. The warning message is in the form
of: “Log file" running low on space - clean up immediately!

Specific recovery actions are provided for /dacscan/trace, dacscan/log,
dacscan/dbarch, and dacscan/users files, if its percentage fill is over
80%. The recovery message for the dacscan/dbarch controller file is:
"Logfile” removed database archive file - back up
database immediately!

The recovery message for the dacscan/trace and dacscan/log filesis:
Removed log files - Archives may be incomplete!

The recovery message for the dacscan/users file is: "Logfile” is
running low on space, clean up immediately!
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System administration

Section VI: Network Map System Administration

Overview
Purpose  This section contains tasks that control the appearance of the Network
Map.
Contents
Install a new background map for all users 4-18
Install a new background map for users of Windows 4-20
PC client machines
Update a network element position 4-22
Add a user defined submap 4-23
Display/modify a user defined submap 4-24
Delete a user defined submap 4-25
O
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Section VI: Network Map System System administration
Administration

Install a new background map for all users

Purpose Usethistask to install a new background map for all users.

Choosing a background A new background map must be selected carefully so that it does not
map  obscure the icons and text displayed with it. For example, a map that
is largely white will hide the white text of the icon names.
When selecting a background map, keep the following in mind:
»  Select amap that is mainly of a different color than the icons
and text displayed on the map.

»  Select a map that includes colors that contrast sufficiently with
the icons and text displayed on the map so that they are easily
distinguished by the user.

Task  Perform the steps below to install a new background map for all
users.

1 Log into the WaveStar TMS as root on the primary host via the
system console.

2  To change to the directory containing the original background map,
enter cd Zusr/dacscan/ui/jui/jnm/itm/data/customer at
the prompt.

3 Enter mv defaultGIS.bshp ../. at the prompt.

Result:

The original background map is moved and saved into another
directory.

4 Enter cp earth._gif
/usr/dacscan/ui/jui/jnm/itm/data/customer/defaul tGIS.gif

Result:

The new map is copied into the directory.
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Section VI: Network Map System System administration
Administration
Install a new background map for all users

5 If the map is for HP workstation client machines, download the
defaultGIS.qgif file to Zuser/add-—
on/ui/jui/jnm/itm/data/customer

If the map is for Windows PC/Windows Terminal Server machines,
download the defaultGIS.gif file to
\jui\jnm\itm\data\customer

6 Start WaveStar TMS.
Result:
The new map displays in the background.

END OF STEPS
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Section VI: Network Map System System administration

Administration

Install a new background map for users of Windows PC client

machines

Purpose

Choosing a background
map

Task

Use this task to install a new background map for users of Windows
PC client machines.

A new background map must be selected carefully so that it does not
obscure the icons and text displayed with it. For example, a map that
is largely white will hide the white text of the icon names.

When selecting a background map, keep the following in mind:

e Select amap that is mainly of a different color than the icons
and text displayed on the map.

*  Select a map that includes colors that contrast sufficiently with
the icons and text displayed on the map so that they are easily
distinguished by the user.

Perform the steps below to install a new background map for
users of Windows PC client machines.

Log into each Windows PC client machine that needs a new map
background as administrator.

To change to the directory containing the original background map,
enter cd \jui\jnm\itm\data\customer a the prompt.

Enter mv defaultGIS_bshp ..\. a the prompt.
Result:

The original background map is moved and saved into a into
another directory.

Enter cp earth._gif
\jur\jnm\itm\data\customer\defaultGIS.gif

Result:

The new map is copied into the directory.
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Section VI: Network Map System System administration

Administration
Install a new background map for users of
Windows PC client machines

5 Start WaveStar TMS.
Result:
The new map displays in the background.

END OF STEPS
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Section VI: Network Map System System administration

Administration

Update a network element position

Purpose

Before you begin

Task

Use the following procedure to update a network element’s position
on the Network Map.

Be sure that you have system administrator or Configuration
Management privileges to permit you to save the updated network
element positions on the Network Map.

Complete the following task to permanently move a node to a
new position on the Network Map.
On the Network Map, select the node you want to reposition.
Drag and drop the node to the new location.
Result:
The node and its connecting links are repositioned.
Select the following menu option: File > Update Node/Label
Locations.
Result:
The network element’s location is updated.
END OF STEPS
U
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Section VI: Network Map System System administration
Administration

Add a user defined submap

Purpose  Use this procedure to add a user defined submap.
Permissions  You must be authorized to perform this task.

Task  Perform the steps below to add a user defined submap.

1 On the Network Map, select Administration > User Defined
Submap > Add

Result:
The Add User Defined Submap form is displayed.

2 Inthe User Defined Submap Name field, enter a name for the
user defined submap.

3 To add member(s) to the new submap, select one or more entries from
the Non-Members list, then click the left arrow button.

Important! You can optionally complete the Filters field to lessen
the number of listed entries.

Result:
The selection(s) are moved to the Members list.

Result:

The new user defined submap is added and the Add User
Defined Submap form closes.

END OF STEPS
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Section VI: Network Map System System administration

Administration

Display/modify a user defined submap

Purpose

Permissions

Task

Use this procedure to display/modify a user defined submap.
You must be authorized to perform this task.

Perform the steps below to display/modify a user defined
submap:

On the Network Map, select Administration > User Defined
Submap > Display/Modify

Result:
The Modify User Defined Submap form is displayed.

In the User Defined Submap Name field, select the submap to be
displayed/modified.
Result:

The selected information displays.

Do one of the following:
*  Make no changes and proceed to the next step.

*  Add member(s) to the submap by selecting one or more entries
from the Non-Members list, then click the left arrow button.

*  Remove member(s) from the submap by selecting one or more
entries from the Members list, then click the right arrow button.

Result:

The submap is modified if changes were made.
END OF STEPS
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Section VI: Network Map System System administration
Administration

Delete a user defined submap

Purpose Use this procedure to delete a user-defined submap.
Permissions  You must be authorized to perform this task.

Task  Perform the steps below to delete a user defined submap:

1 On the Network Map, select Administration > User Defined
Submap > Delete...

Result:
The Delete User Defined Submap form is displayed.

2 Inthe User Defined Submap Name field, select a map name from
the pull down menu.

Result:

The selected information displays.

Result:
The user defined submap is deleted.

END OF STEPS
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System administration

Section VII: Set Preferences

Overview
Purpose  This section defines how to set map preferences in WaveStar TMS.
Contents
Set map preferences 4-27
]
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Section VII: Set Preferences System administration

Set map preferences

Purpose  Use this procedure to set map preferences.

Task  Perform the steps below to set map preferences.

1 On the network map, select Administration > Preferences.
Result:

The Preferences form is displayed.

IF THEN
You want to select a highlight an entry in the User Login
different map View’s drop down list.
You want to set the link select the Normal or Heavy button.
width value,
3 Sdect OK
Result:
The form closes. Changes to the map will take effect during the
next and subsequent sessions.
END OF STEPS
]
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System administration

Section VIII: Miscellaneous system administration

Overview
Purpose  This section describes some miscellaneous system administration
tasks.
Contents
Search for location-type information for a specific 4-29
network element
Search for controlled network elements 4-30
Display the software version humber 4-31
Display patch information 4-32
[l
4-28 Lucent Technologies 365-309-800

Issue 1, July 2001



Section VIII: Miscellaneous system System administration

administration

Search for location-type information for a specific network

element

Purpose

Task

365-309-800
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Use this procedure to search for location-type information for a
specific network element.

Important! The search is limited to network elements that are
controlled or cataloged by WaveStar TMS.

Perform the steps below to search for location-type information
for a specific network element.

Select Location Reference Table.
Result:
The Location Reference Table Query Box is displayed.

In the Office Location/NE ID field, enter the location type
information.

Result:

The Location Reference Table appears and displays location-type
information.
END OF STEPS
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Section VIII: Miscellaneous system System administration

administration

Search for controlled network elements

Purpose

Task

Use this procedure to search for alist of network elements with which
WaveStar TMS works and for information about the digital
cross-connect systems that are part of the network.

Perform the steps below to search for controlled network
elements and digital cross-connect systems that are part of the
network.
On the Network Map, select Administration > Location
Reference Table.
Result:
The Location Reference Table Query Box is displayed.
In the Office Location/NE ID field, enter the network element
information.
Enter criteriain Additional Information, if desired.
Select the Area ID from the drop-down list.
Select OK
Result:
The Location Reference Table form with the queried information
is displayed.
END OF STEPS
U
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Section VIII: Miscellaneous system System administration
administration

Display the software version number

Purpose Use this procedure to display the version number of WaveStar TMS.

Task  Perform the following steps to display the version number of
WaveStar TMS.

1 From the Network Map, select Help > Version.

Result:

The currently installed software version and build date are
displayed.

END OF STEPS
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Section VIII: Miscellaneous system System administration
administration

Display patch information

Purpose  Use this procedure to display the patch information for WaveStar
TMS.

Task  Perform the following steps to display the patch information for
WaveStar TMS.

1 On the Network Map menu bar, select Help > Version.

Result:
The currently installed software version and build date are
displayed.
END OF STEPS
U
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5 Provisioning environment setup

Overview
Purpose  The provisioning environment setup involves using tasks to initialize
WaveStar TMS and to support inter-domain provisioning.
O
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Provisioning environment setup

Provisioning environment setup

Tools  Provisioning environment setup is supported through the following
off-line tools:

*  Bulk Link Provisioning tool
*  Bulk Load tool

* Add Controller tool

*  Delete Controller tool

For more information about these tools, see Chapter 7, “ Off-line Tool
Concepts’.
O
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6 Reliability and service recovery

Overview
Purpose  This chapter describes tasks performed to insure the reliability of
WaveStar TMS and procedures for system recovery if WaveStar TMS
becomes unavailable.
Contents
Section |: Perform backups 6-2
Perform a hot backup 6-4
Perform a cold backup 6-5
Section |1: Perform recoveries 6-6_
Perform a hot backup recovery 6-7_
Perform a cold backup recovery 6-8
Section I11: Miscellaneous reliability and service 6-10
recovery tasks
Obtain mirroring status 6-11
]
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Reliability and service recovery

Section |I: Perform backups

Overview

Purpose

Regular backups

Host database backup

Hot backup

This section describes how to perform various types of backups.

The system can be set to perform daily backups. The time for the
daily backupsis set in the cron file. For information on how to edit
the cron file, see Chapter 4, “ System administration”.

Two types of backup are available:
*  Hot backup
e  Cold backup

Hot backups occur when the system is up and running (hot). Cold
backups occur when the WaveStar TMS is shutdown (cold). The hot
backup takes longer to complete than the cold backup, but the hot
backup can be initiated while WaveStar TMS is running. The
application must be stopped before a cold backup can be initialized.

There are two types of hot backup available:
e Automatic
*  User-initiated
The system automatically backs up the database on Sunday, Tuesday,
Wednesday, Thursday, and Friday at 2:00 am. if a tape is present in
the tape drive.
The hot backup takes from 60 to 180 minutes to complete, depending
on the size of the database.
No operator action is required during the hot backup. The system is
required to be at run level 4 for hot backup.
The default database backup retention is 5 days (5 tapes/rotation).
The frequency of the hot backups and the time can be altered in the
cron file.
Important! It is recommended that you maintain scratch tape in the
standby HP 9000 processor.
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Section |: Perform backups
Overview

Cold backup

Contents
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Reliability and service recovery

A cold backup is the most accurate type of backup.

Operator action is required during the cold backup procedure. The
system is required to be at run level 3 for cold backup.

Cold backups should be run every week and the system must be
down.

Perform a hot backup 6-4
Perform a cold backup 6-5

]
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Section |: Perform backups

Reliability and service recovery

Perform a hot backup

Purpose

Task

A hot backup occurs when the system is up and running.

Perform the steps below to perform a hot backup.

Insert a tape into the tape drive.

Important! Wait until the lights on the tape drive stop flashing.

Enter /bin/ksh ./hot_backup
Result:

The hot backup begins. This will take 60-180 minutes to
complete. The # prompt is issued to the system console once the
backup is complete.

Label the tape with the current date, and store the tape in a safe place.
Result:

The hot backup is complete.
END OF STEPS
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Section |: Perform backups

Reliability and service recovery

Perform a cold backup

Purpose A cold backup occurs when the WaveStar TMS is shutdown (cold).
Task Perform the steps below to perform a cold backup.
1 Using the system console, log into the system as root.
2  Stop WaveStar TMS.
Reference:
For instructions, see the “Shut down the WaveStar TMS
application” (2-27) task in Chapter 2, “Platform Administration”.
3 Login to the WaveStar TMS server as root.
4 Insert atape into the tape drive.
5 Wait until the lights on the tape drive stop flashing.
6 Enter cd /usr/dacscan/bin
7 Enter /bin/ksh cold_backup
Result:
The cold backup begins. This will take approximately 40
minutes to complete. The # prompt is issued to the system
console once the backup is complete.
8 Remove the tape.
9 Label the tape with the current date, and store the tape in a safe place.
Result:
The cold backup is complete.
END OF STEPS
................................................................................................................................................................................................................................ [
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Reliability and service recovery

Section |l: Perform recoveries

Overview

Purpose  This section describes how to perform a recovery if a system failure
ocCurs.

Types of recoveries  Two types of recovery are available:
*  Recovering a hot backup
*  Recovering a cold backup

Contents
Perform a hot backup recovery 6-7_
Perform a cold backup recovery 6-8
]
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Section Il: Perform recoveries Reliability and service recovery

Perform a hot backup recovery

Purpose Use this procedure to perform a hot backup recovery. Hot backups are
recovered using the “hot_recover” script.

Before you begin  WaveStar TMS must be shut down to perform this procedure.

Task  Perform the steps below to perform a hot backup recovery.

2 Stop WaveStar TMS.
Reference:

For instructions, see the “Shut down the WaveStar TMS
application” (2-27) task in Chapter 2, “Platform Administration”..

6 Enter /bin/ksh ./hot_recover
Result:

The hot backup recovery begins. This will take approximately
90 minutes to complete. The # prompt is issued to the system
console once the hot backup recovery is complete.

8 Restart the TMS application.
Result:

The hot backup recovery is complete.
END OF STEPS
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Section Il: Perform recoveries Reliability and service recovery

Perform a cold backup recovery

Purpose  Use this procedure to perform a cold backup recovery. Cold backups
are recovered using the “cold_recover” script.

Before you begin  WaveStar TMS must be shut down to perform this procedure.

Task  Perform the steps below to perform cold backup recovery.

2 Stop WaveStar TMS.
Reference:

For instructions, see the “Shut down the WaveStar TMS
application” (2-27) task in Chapter 2, “Platform Administration”.

6 Enter /bin/ksh ./cold_recover
Result:
A prompt appears and asks for the date of the backup tape.
7  Enter YYYYMMDD (or YYMMDD for older tapes).
Important! The date entered must match the date on the backup tape.
Result:

The cold backup recovery begins. This will take approximately
90 minutes to complete. The # prompt is issued to the system
console once the backup is complete.
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Section Il: Perform recoveries Reliability and service recovery
Perform a cold backup recovery

8 Remove the tape.
9 Restart the TMS application.
Result:

The cold backup recovery is complete.
END OF STEPS
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Reliability and service recovery

Section II1: Miscellaneous reliability and service recovery tasks

Overview
Purpose  This section describes how to perform miscellaneous reliability and
service recovery tasks.
Contents
Obtain mirroring status 6-11
L]
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Section I11: Miscellaneous reliability and Reliability and service recovery

service recovery tasks

Obtain mirroring status

Purpose

About the mirrored disk

configuration

Before you begin

Task

365-309-800
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Use this procedure to obtain mirroring status. This task is used to
verify that the application and databases residing on separate disks are
synchronized.

A mirrored disk configuration eliminates the need to have a second
processor to serve as a backup. The application and database that
reside on separate disks are mirrored onto a second set of disks.
Information that is written to disk is reflected onto the mirrored
counterpart. It is recommended that the mirroring stetus is checked
from time to time to ensure that al the mirrored information is
synchronized with the primary information.

Ensure that the LVSTATUS is set to SYNC.

Perform the steps below to obtain mirroring status:

Enter vgdisplay -v | pg a the # prompt.
Result:

The mirroring status displays.

END OF STEPS
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7 Off-line Tool Concepts

Overview
Purpose  This chapter describes off-line script tools provided with WaveStar
TMS. It also contains tasks associated with off-line tools.
Contents
Section |: Bulk Link Provisioning tool 7-2
Bulk link provisioning tool task 7-3
Section |1: WaveStar NMS to WaveStar TMS 7-5
Data Population tool
WaveStar NMS to WaveStar TM'S Data Population 7-6
tool task
Section I11: WaveStar TMS Merge Circuit tool 7-9
WaveStar TMS Merge Circuit tool task 7-11
Section IV: Add DMS tool 7-13
Add a DMS to the Network Map using the Add 7-14
DMS tool
Section V: Delta export/import of optical 7-16
links/path tool
[l
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Off-line Tool Concepts

Section |: Bulk Link Provisioning tool

Overview

Purpose  This section describes the bulk link provisioning tool, which is used
to perform a bulk transfer of topological links from provisioning
systems, e.g., the Physical Resource Manager to WaveStar TMS. This
off-line tool abstracts the topological links into a bulk process then
performs a bulk add of the links to WaveStar NMS as if they were
added individually through the WaveStar NMS GUI.

About this tool  Before running this tool, an input file is created which contains one
line per NMS (or TMS) link to be provisioned. The created file is
entered in the bulk link provisioning tool command and run with
certain options.

Contents

N
w

Bulk link provisioning tool task
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Section I: Bulk Link Provisioning tool Off-line Tool Concepts

Bulk link provisioning tool task

Purpose

Before you begin

Task

This section describes how to perform bulk link provisioning in
WaveStar TMS.

Consider the following before running the bulk link provisioning tool.

Important! This tool is expected to be run during off-hours to avoid
the impact that the process may have on system response.

Complete the following steps to run the bulk link provisioning
tool:

Log into the server as dacscan then enter cd
/usr/dacscan/toolbin.

In the input file, add one row of the following data, separated by the |
character for each WaveStar TMS link to be provisioned.

. The full A’ network element identifier <aloc>.
. The full ’Z’ network element identifier <zloc>.

*  The network element-level port address of the service link at the
A location.

*  The network element-level port address of the service link at the
Z location.

»  The coded rate of the link <link_type>.
*  The free-format label for the circuit ID field <link_ID>.

e The coded Multiplex Section Protection (MSP) configuration.
Values are 1X1MSP, 1+MSP or none.

* The free-format label denoting the protecting link or none.

*  The network element-level port address of the protecting link at
A_location or none.

*  The network element-level port address of the protecting link at
Z location or none.

365-309-800
Issue 1, July 2001

Lucent Technologies 7-3



Section I: Bulk Link Provisioning tool Off-line Tool Concepts
Bulk link provisioning tool task

*  The MSP protection group name for 1X1MSP or none.
*  The type of MSP configuration: UNI, BI, NTT or none.

Note that if the row is being created for MSP links, the protecting
link and service link fields must be consistent for the sequential array
of fields. The row must also have the same A network element ID and
Z network element ID while conforming to the correct MSP port
groupings at either end. The protecting link and service link must aso
have the same link ID.

4  Save and close the file, then select one of the following options from

the next step.
5 IF THEN
You want to validate data enter linkgroup_prov NM_links -v
in the input file without Result:
rovisioning links, L .
P g All records in the data file are
validated and error messages are
logged to a file.
You want to provision enter linkgroup_prov NM_links -p
In-Effect a group of links, Result:
A group of links are provisioned.
You want to take the latest | enter linkgroup_prov NM_links -a
provisioning run and audit Result:
the WaveStar NMS N .
database against the inout The run is audited and any
i &g P non-In-Effect links are noted in the
file, link_audit.log error file.
END OF STEPS
[
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Off-line Tool Concepts

Section |I: WaveStar NMS to WaveStar TM S Data Population

tool

Overview

Data

Purpose

About this tool

Collection Tool

Data Load Tool

Contents

This section describes the WaveStar NM S to WaveStar TMS Data
Population tool. This tool is used to populate the WaveStar TMS
Database when bringing a Domain Management System (DMS) under
the TMS layer.

The WaveStar NM S to WaveStar TM S Data Population tool contains
two parts:

» Data Callection Tool (DCT)
 DatalLoad Tool (DLT)

The Data Collection part of this tool exports data from the WaveStar
NMS layer, places it into standard ascii format, then transmits the data
from WaveStar NM S to WaveStar TMS via ftp. This tool retrieves
each DM S-managed network element’s optical links, optical
multiplexed sections, optical channel trails, digital links and paths.
This includes unprotected digital links and both protected and
unprotected paths or path segments.

When the DCT is run, it automatically creates a directory to store
data.

The Data Load part of this tool imports data from the WaveStar NM S
layer into the WaveStar TMS. The Data Load tool enables users to
load either a single entity or multiple types of entities at one time.
The DLT produces an audit data file stored separately from the
collected output file. The audit file contains a log of successfully
loaded data and errored records.

WaveStar NMS to WaveStar TMS Data Population 7-6_
tool task
]
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Section |l: WaveStar NMS to WaveStar Off-line Tool Concepts

TMS Data Population tool

WaveStar NMS to WaveStar TMS Data Population tool task

Purpose

Before you begin

Task

This section describes how to use the WaveStar TM'S Data Popul ation
tool.

Before running the WaveStar TM S Data Population tool:

* Note that the state of the WaveStar TMS and DMS should be
idle - no provisioning operations should be performed when the
Data Collection Tool is run.

*  Besure to provide sufficient space and settings to enable the
software to run without encountering storage problems.

*  Be sure to process information for one DMS at a time.

Complete the following steps to run the WaveStar NMS to
WaveStar TMS Data Population tool:

Log into the server as dacscan then enter cd
fusr/dacscan/toolbin.

Create a set of UNIX files for each exported entity type.

Each file should contain the following sections.
» Data Types, including Label, HexString, Integer, and NEID.

* Managed Elements, including name, nativeEMSname,
version, and ProductName.

e Optical Link and Optical Multiplexed Sections, including
link_type, link_ID, aloc, and zloc.

*  Optical Channel Trail, including och_type, och_label, a_loc,
and z_loc.

» Digital Link, including link_type, link_ID, aloc, and zloc.

» Path Representation, including pathtype, pathlabel, a_loc,
and z_loc.

Note that each file should contain lines which are terminated by a
newline character 'OA’H. Each field within the lines should be
separated by the | character.
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Section |1: WaveStar NMS to WaveStar Off-line Tool Concepts
TMS Data Population tool

WaveStar NMS to WaveStar TMS Data

Population tool task

3 Saveeachfilein
<dms_name>.<entitytype>.XX.<XX>.<mnemonic>.<YYMMDD.HHmmn
format and close the files.

Important!

The following describes the above parameters:

 <dms_name> represents the name of the DMS from which data
IS extracted.

* entity type isthe kind of data, i.e., dl for digita link, ol-oms
for optical link, and multiplexed sections, etc.

XX isthe WaveStar NMS version.

e mnemonic is the Network Element mnemonic.

*  YYMMDD represents the year, month, and day of the extraction.
*  HHmMmMSS is the hour, minutes, and seconds of the extraction.

* sequence identifier is provided if needed.

4 From the cd /usr/dacscan/toolbin directory, enter net_entity.ksh
-n net_entity -e [-h] to run the DCT tool.

Important! Note that -n net_entity represents the required network
entity to be processed, i.e.,
managed_ne|optical_link|optical_trail|digital_link|path. -e is
used to export the network entity from NMS to afile. -h prints the
command usage message.

Result:

The DCT exports data from the WaveStar NMS layer, places it
into standard ascii format. Data is then manually transmitted via
ftp from WaveStar NMS to WaveStar TMS. Results are stored
in a directory created by the DCT.

5 From the cd /usr/dacscan/toolbin directory, enter net_entity.ksh
-n net_entity -i [-vabh] [-f input_file] to run the DLT tool.

Important! Note that -n net_entity represents the required network
entity to be processed, i.e.,
managed_ne|optical_link|optical_trail|digital_link|path. -f
input_file represents the file from which to read the entities to be
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Section |l: WaveStar NMS to WaveStar Off-line Tool Concepts

TMS Data Population tool
WaveStar NMS to WaveStar TMS Data

Population tool task
imported. The file is assumed to be in /tmp/net_entity unless the

full path is specified. If nofileis
specified, the user is prompted to confirm alist of files to process.
The files must adhere to the naming convention:
ltmp/net_entity/*net_entity.action.current

Result:

The DLT imports data from the WaveStar NMS layer into the
WaveStar TMS. The tool produces an audit data file stored
separately from the collected output file. The audit file contains
alog of successfully loaded data and errored records.

6 From the cd /usr/dacscan/toolbin directory, run the WaveStar
TMS Merge Circuit tool. See “WaveStar TMS Merge Circuit tool
task” (7-11) for details.

END OF STEPS
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Off-line Tool Concepts

Section |II: WaveStar TMS Merge Circuit tool

Overview
Purpose  This section describes the WaveStar TMS Merge Circuit tool which
supports the merging of in-effect, interdomain circuits/paths.

About this tool  The WaveStar TMS Merge Circuit tool searches the WaveStar TMS
database for interdomain links that can be used for merge processing.
This tool maintains a list containing interdomain link port candidates,
and updates the list when an interdomain link’s port has been used, so
as to not revisit it in future processing.

The WaveStar TMS Merge Circuit tool next locates a path which
terminates on an interdomain link port and that has a continuation in a
neighboring domain. The tool then updates the WaveStar TMS
database with the merge operation and notifies WaveStar NMS to
update the DMS userLabel field with the name of the merged
circuit.

Input file  The WaveStar TMS Merge Circuit tool uses an input data file with
ASCII text and multiple, non-empty lines. Each line contains fields
separated by |. Thereis no | at the beginning of the line but a | must
be present at the end of the line.

The tool can handle multiple merged circuits in one file. For each
merged circuit in the file, it should start with a"PATH_BEGIN" line,
and ended with a "PATH_END" line.

Input file format  The Input data file format is:
PATH_BEGIN|
merged_ckt_id]a_loc]z_loc]a_port]z_port]prot_type|a _prot_I
to_be merged_ckt_idl]
to_be merged_ckt id2]

to_be _merged_ckt_idN]
PATH_END|

365-309-800 Lucent Technologies 7-9
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Section Ill: WaveStar TMS Merge Circuit Off-line Tool Concepts
tool

Overview
PATH_BEGIN]
PATH_END]|
Contents
WaveStar TMS Merge Circuit tool task 7-11
[l
7-10 Lucent Technologies 365-309-800
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Section I11: WaveStar TMS Merge Circuit Off-line Tool Concepts
tool

WaveStar TMS Merge Circuit tool task

Purpose  This section describes how to use the WaveStar TMS Merge Circuit
tool.

Before you begin  Before running the WaveStar TMS Merge Circuit tool:

* Note that the merge will be valid only on paths with no circuits
riding on them.

Task Complete the following steps to run the WaveStar TMS Merge
Circuit tool:

1 Log into the server as dacscan then enter cd
/usr/dacscan/toolbin.

2 Enter pathMerge <input data file path name> to run the
WaveStar TMS Merge Circuit tool.

Result:
The WaveStar TMS Merge Circuit tool:

*  searches the WaveStar TMS database for interdomain links
and their endpoints that can be used for merge processing.

*  searches the WaveStar TMS database for intradomain paths
terminating on the identified end port.

e  merges circuits across the interdomain link by populating
the DMS Userlabel field with the circuit ID of one of the
merged circuit's component circuits. The interdomain link
is then marked as used.

*  Verifies whether or not the circuit is cross connected. If so,
the tool searches for additional interdomain links across
which it may be additionally merged. If not, then the tool
returns to the list to perform additional processing.

*  Produces audit logs(s) containing positive and negative
results of the merge circuit tool which is stored in afile or
files.

If the user has provisioned a Black box to a node, and the WaveStar
TMS user wants to provision an inter-domain link between this node
and another node in another domain to which it also may or may not

365-309-800 Lucent Technologies 7-11
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Section Ill: WaveStar TMS Merge Circuit Off-line Tool Concepts

tool

WaveStar TMS Merge Circuit tool task

be provisioned , the operation from WaveStar TMS may be successful,
but the order implementation at WaveStar NM S will fail. This will
occur since the port(s) are in use by the link to the Black boxe(s).

In this casg, it is recommended that the user first deletes the black
boxes locally at the relevant WaveStar NMS and then creates the
inter-domain link from WaveStar TMS.

When the user requests to merge a number of subnetwork connections
from WaveStar TMS, if one or more of the requests fail to lower level
management system, the WaveStar TM S will display a message
indicating that the merge update of the WaveStar TMS circuit ID
failed for the WaveStar NMS circuit ID in WaveStar NMS. The merge
will complete in this case however setUserLabel has faled. In this
case, the user will have to locally go and modify the circuit ID in the
appropriate network management system through modify order
parameters.

END OF STEPS
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Off-line Tool Concepts

Section 1V: Add DMS tool

Overview
Purpose  This section describes how to add or delete a DM S using the add or
delete controller tools. Note that the term controller in this section
refers to domain map.
Contents
Add a DMS to the Network Map using the Add 7-14
DMS tool
]
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Section 1V: Add DMS tool

Off-line Tool Concepts

Add a DMS to the Network Map using the Add DM S tool

Purpose

Before you begin

Task

Use this task to add a DMS to the WaveStar TMS Network Map
through the Add DMS tool. The task adds WaveStar NMS controllers
to the controller map and then popul ates the WaveStar TM S Network
Map with areas, representing the domains of the added controllers.

Important! This task must be run for each DMS to be added. Up to
24 DM Ss may be added.

Before you begin this task, be sure to obtain access to:

. WaveStar NMS software with ITM-SC, WaveStar SNM S and
their associated network elements.

. WaveStar TMS

Perform the steps below to add a DMS to the WaveStar TMS
Network Map.
Log in to each DMS host.
At the prompt, enter who -r to make sure that the run level is at run
level 4.
Using the system console, log in to the WaveStar TMS host as root.
Determine the following:
* If the application is running, enter init 3.
At the prompt, enter /usr/dacscan/bin/add.DMS
Result:
A prompt displays.
At the prompt, enter the DMS name.
Important! The entered DMS name value should be upper case and
meaningful since it will display in the GUI.
Lucent Technologies 365-309-800
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Section 1V: Add DMS tool Off-line Tool Concepts
Add a DMS to the Network Map using the
Add DMS tool

Result:
A prompt displays.

6 Enter the acronym of the DMS.
Result:
A prompt displays.

7  Enter the IP address of the DMS.
Result:

A successful add message displays.

10 Open the WaveStar TMS Controller Map.

11 View the WaveStar TMS Controller Map and verify that it displays
the name of the new DMS, which is preceded by DMS .

12 Start communication from the WaveStar TM S Controller Map.

Result:

The new DMS should be able to establish communication with
WaveStar TMS and the DMS icon on the WaveStar TMS should
be green.

END OF STEPS

365-309-800 Lucent Technologies 7-15
Issue 1, July 2001



Off-line Tool Concepts

Section V: Delta export/import of optical links/path tool

Overview

Purpose Information not available.

About this tool Information not available.
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Section V: Delta export/import of optical Off-line Tool Concepts
links/path tool

Delta export/import

Overview Information not available.
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8 Management communication

Overview
Purpose  This chapter describes tasks performed to interact with subsystems in
the network.
Contents
Section I: Interact with domain management 8-2
systems
Synchronize the WaveStar TMS database with a 8-3
DMS database
]
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Management communication

Section I: Interact with domain management systems

Overview
Purpose  This section describes the administration of domain management
systems.

Definition: Domain DMS is part of a telecommunications management network that
Management System  provides comprehensive and integrated management of an entire
(DMS)  transport network.

Contents
Synchronize the WaveStar TMS database with a 8-3
DMS database
]
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Section |: Interact with domain management Management communication

systems

Synchronize the WaveStar TM S database with a DM S database

Purpose

Task

Use this procedure to synchronize the WaveStar TM S database with a
DMS database.

Complete the following task to synchronize the WaveStar TMS
database with a DM S database.

From the Network Map, select File > Open DMS Controller Map.
Result:
The DMS Controller Map displays.

Right-click the DMS node with which WaveStar TMS will be
synchronized.

Select Session > Start DMS Synchronization.
Result:

The Database Download/Synchronization form is displayed. The
DMS ID field is pre-populated with the name of the DMS.

In the Sync Type field, select one of the following:
* Network Elements
 Topological Links
 Subnetwork Connections
Select Apply.
Result:

A confirmation form appears.

Result:
The Database Synchronization Status form appears.

365-309-800
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systems
Synchronize the WaveStar TMS database
with a DMS database

7  Wait for the synchronization to complete.

8 Sdect Close.

Result:
The WaveStar TMS database is synchronized with the DMS
database.
END OF STEPS
]
8-4 Lucent Technologies 365-309-800

Issue 1, July 2001



Lucent Technologies
Bell Labs Innovations

9 Trouble clearing

Overview

Purpose

WaveStar TMS home
directory

Definition: trace file

Contents

365-309-800
Issue 1, July 2001

This chapter describes how to turn on trace and view trace files.

The home directory of WaveStar TMS is /usr/dacscan. The
application servers reside in the bin directory of the home directory.
Each server has trace information linked to it and it can be turned on
and off via the tinfo filein /Jusr/dacscan/bin.

Important! The trace files should never be removed while the
application is up under any circumstances.

A trace file contains information that identifies equipment status at a
given point in time. The typical use of a trace file is to send it to
Lucent technical support to be used as part of their remote
troubleshooting activities.

Create a trace file on an HP server 9-2
Create a trace file on a Windows PC 94
View the core file 95
View the log files 9-6
View the log file on an HP server 9-7
View the console.log file on a Windows PC 9-8

L]
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Trouble clearing

Create a trace file on an HP server

Purpose

Before you begin

Task

Use this procedure to turn on trace at a particular server and to create
a trace file for capturing information.

I mportant! Trace files should never be removed.

Before you begin this task, ensure that the application is at run level
3.

Perform the steps below to create a trace file.

Enter the command who -r to check the current run level.
Result:
The run level number displays, such as run-level 3.

If the displayed run level is higher than 3, enter the command init
3 to bring the application up to run level 3.

At the prompt, enter cd /usr/dacscan/bin to change to the directory
containing the tinfo file.

In the tinfo file, locate a line containing the following format:
<servername> -1 0 <servername>. 0 Y

Important! In your tinfo file, <servername> will be replaced with
the actual server name.

Change the first occurrence of 0 to 5.
Result:

The line should now display:

Lucent Technologies 365-309-800
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<servername> -1 5 <servername>. 0Y

At the prompt, enter init 4 to bring the application up to run level 4.
Result:

Trace is turned on. A trace file is generated and is called
<servername>.<pid>.

Verify that the trace file /dacscan/trace/<servername>.<pid>
exists.

Result:

The file displays in the appropriate directory.

END OF STEPS
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Create a trace file on a Windows PC

Purpose

Task

Use this procedure to create a trace file for capturing information on a
Windows PC.

I mportant! Trace files should never be removed.

Perform the steps below to create a trace file on a Windows PC.

IF THEN

you want to increase global | edit the /usr/add-on/ui/jui/bin/run_
tracing and turn on jnm file by changing gt=1 to gt=4
F-interface tracing at an fint.tr=4

HP-UX console,

you want to increase global | edit the <drive>:\jui\bin\run_jnm.bat

tracing and turn on file by changing gt=1 to gt=4
F-interface tracing at a PC | fint.tr=4
console,

Shut down and restart the WaveStar TM'S application.

See the “Shut down the WaveStar TMS application” (2-27) and
“Power on HP server (single server configuration with mirrored
disks)” (2-4) tasks in Chapter 2, “Platform Administration”.

Result:

Tracing is turned on and a trace file is generated.
Verify that the trace file exists.

Result:

The file displays in the appropriate directory.

END OF STEPS
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View the core file

Purpose

Definition: core file

About the core file

Task

365-309-800
Issue 1, July 2001

Trouble clearing

Use this procedure to view the core file created when a server dies.

The core file contains information that identifies which process died
and caused the core dump. It is used during troubleshooting to help
identify what caused the server to die.

When a server shuts down, a core file may be created in
/usr/dacscan/bin. The core file reveals the identity of the server.
Because the server is automatically restarted, service on that particular
function of the system is only impacted for a brief period. Until it has
restarted, information will not be lost because the system’s bulletin
board will buffer services requested upon that server.

Perform the steps below to view the core file.

Enter the following command: file core
Result:

The contents of the core file is displayed.
END OF STEPS
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View the log files

Overview  Operator transaction logs are stored in compressed format in the
/dacscan/log/data directory with the following naming convention:

<log-prefix>.<julian-date>.<hour>.<minute>
The following is a list of log files:

*  sys(System Event) - records all system error messages. File
name is tms.log.<hostname>.

* Server log file - Logs process event and error information. File is
stored at /dacscan/log/data/tms.log.

« PCclient log file - The file is stored at
<drive>:\jui\logs\<user>.log

All log files are maintained up to seven days, the oldest file is
overwritten first. One log file is retained for each day of the week.

Log Files  All significant events associated with the database backup and transfer
scheme are logged.

The events are also retained in log files in /dacscan/tmp.
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View the log file on an HP server

Purpose Use this procedure to view the log file residing on an HP workstation.

Task  Perform the steps below to view the log file.

2  Change to the directory containing the log file to be viewed. Type cd
/<full_directory_path>

3 Enter pg <logfilename>.log
Result:

The contents of the log file is displayed.

END OF STEPS
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View the console.log file on a Windows PC

Purpose  Use this procedure to view the console.log file residing on a PC.

Task  Perform the steps below to view the log file.

2 Using Notepad or Wordpad, display the console.log file which
residesin
/home/<user>/NM/<workstationname>.<pid>/jui/logs/console.log

Result:
The file displays.
END OF STEPS
U
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10 Patch and Software Upgrade
Tasks

Overview

Purpose  This chapter will contain WaveStar TM S patch and upgrade
information.

Information  Information not available.

Contents
Patch information 10-2
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Patch information

Description  Information not available.
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Appendix A: Installation Parameters

Overview

Introduction  This Appendix contains non-obsolete WaveStar TMS configuration
parameters.

Header Files  There are three header files, two of which are auto-generated. The
only maintained header file is nms_param.h which itself includes
the relevant public auto-generated header file.

Parameter numbers ParamNo are defined as the name of the
parameter, capitalized and prefixed by SA_. The parameter BER
would have a ParamNo of SA_BER.

To obtain the value of a parameter, you need to know its ParamNo
and type (i.e., Scalar or String). The ParamNo is unique across both
types, to help detect calls to ‘get’ functions with the wrong type of
ParamNo. Any process wishing to obtain the value of a parameter
must include nms_param.h.

Values  Certain ‘well known’ pre-defined values are defined in the maintained
header file nms_param.h. If you need to use any other values, they
must be added to this file. Currently defined values are TRUE /
FALSE, ON / OFF and YES / NO which are all defined as 1/ 0
respectively. These values may be used as numeric entries in the
tables below.

365-309-800 Lucent Technologies A-1
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WaveStar TMS Parameter Table

Installation Parameters

Parameters
Parameter

ALARMED_PATH_SUPPRESSION

ALM_DEL_OPTION

ALM_THRESHOLD

BILLING_INTERFACE

BILL_COMPUTER

BILL_DIRECTORY

BROADCAST

CHANNEL_SELECTION

Description and Values

Whether alarmed path
suppression is on or
off. Mininum value is
False; Maximum
value is True.

Configurable options
for the deletion of
persistent alarms.
Values are
UNACK_ACK, ACK,
UNACK,
ENF_CLR_ACK

Keeps track of alarm
aging period in
seconds - for preplan
only.

For billing interface
feature. (1 = TRUE; O
= FALSE)

Name of the bill
computer.

Name of the bill
directory.

Broadcast family
function enabled.
Values are off; on

Determines the method
to use for channel
selection. Values are
LOWEST_TIMESLOT _
FIRST, BEST _USAGE

A-2 Lucent Technologies

Default Value

False

UNACK_ACK

45

0

off

BEST_USAGE
365-309-800
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WaveStar TMS Parameter Table

CKTEMT

CKTFMTSTR

COMBO_PROVISIONING

COUNTRY

CURR_ALM_STORAGE_LIMIT

CYCLIC

DATE_FORMAT

365-309-800 Lucent Technologies
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Installation Parameters

Describes the circuit AZTYPEID
and format. Values are:

AZTYPEID,
IDTYPEAZ,FREEFORMAT,
AZTYPEID:FREE,
IDTYPEAZ:FREE

Stores the format of %s %s %s %s
the circuit 1D. Values

are: %s - %s %s

%5s,%s %s %s.%s,%s

%s %s %s

Configures combo off
provisioning. Values
are off and on.

Country codes used USA
during installation.

Values are: FRANCE,

GCL, GER, HOL,
INDONESIA, JAPAN,

KSA, MEX,
PHILIPINES,PRC,

SPAIN, TAIWAN,UK,

USA

Configurable record 10000
limit for current

alarms. Minimum

value is 10000;

maximum is 200000.

Cyclic scheduler off
function enabled.
Values are off, on.

The format for the
date. Values are
AMERICAN,
EUROPEAN,
YYYYMMDD

EUROPEAN



WaveStar TMS Parameter Table Installation Parameters

DBPVAR Geographical Domain
Partitioning view.
Values are
“READALL” for see
all nodes or "” for
See-Own-Nodes.

DNA_INCR_UPD Controls the database | OFF
trigger supporting the
DNA incremental
update feature. Values
are OFF,ON

ENTERPRISE The default service
partitioning name.
Values are ENTPRISE,
user-supplied for Other
or " for none.

FIX_TUG_STRUCT Fixed TUG structure off
functionally enabled.
Values are off, on.

FM_APPROACH Two distinct modes alarm
identified for the
operation of Fault
Management (FM)
which are Service
approach (top down
mode) and the Alarm
approach (bottom up
mode). They affect
whether the NES or
NEV form of the
network event list is
displayed and certain
other behavior of the
FM screens. Values are
alarm, service

FM_EVENT LIST_SIZE The number of events | 100
(lines) to be displayed
on the NEV/NES
window. Min. value is
100; Max value is
500.

A-4 Lucent Technologies 365-309-800
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FM_NASS_INTERVAL

FM_POLLING_INTERVAL

FM_SYSTEM

FRENCH

GERMAN

HIST_ALM_STORAGE_LIMIT

HIST_RM

IMP_DISC_UN_XC

INC_PPRSV_CHANS_IN_RTE

365-309-800 Lucent Technologies
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Installation Parameters

Alarm summary update | 60
interval. (Range value;
1,300)

The interval time (in 60
seconds) for polling to
update the counters on

the NES or NEV.

Minimum value is 30;
maximum value is 60.

Fault Management CORBA
System Flag. Values

are CORBA,

NON-CORBA

French language off
supported? Values are
on, off

German language off
supported? Values are
on, off

Configurable record 100000
limit for historical

alarms. Minimum val

ue is 10000; maximum

value is 300000.

Keep track of 180
disconnect history

orders. Values are 1 to

180

Improper off
disconnect/uncorrelated
cross-connect function
enabled. Values are

off, on

Defines whether to NO
include pre-planned

reserved channels in
restoration order or

not. Values are YES,

NO



WaveStar TMS Parameter Table

INTEGER_PORT _ID

INTEGER_SNC_ID

KANJI

LB

LOWER_LVL_CKT_PREEMPT

MERGE_CIRCUIT

NB_ALARMS

NB_CMISE

NB_CONFIG

To determine if client
uses TP IDs generated
by ITM-NM to access
the frame address and
location. Values are
TRUE for QNN
interface; FALSE for
PRM interface.

To determine if
SNC_ID is integer or
not. Values are TRUE
for ONN interface;
FALSE for PRM
interface.

Kanji language
supported? Values are
off, on.

Loop back
functionality enabled.
Values are off, on.

Lower level circuit
pre-emption flag.
Values are
Y,YES,N,NO

Merge circuit function
enabled. Values are
off, on

Northbound alarms
function enabled.
Values are off, on

Northbound CMISE
function enabled.
Values are off, on

Northbound
configuration function
enabled. Values are
off, on

Installation Parameters

FALSE

FALSE

off

off

off

off

off

off
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NB_EVTRCVR

NB_NOTIF

NB_RSPMGR

NMS_NB_NAME

NMS_PORT_TABLE

NB_THR_SIZE

OFFICEDELIM

PAMS

PAMS_ACCOUNT_NAME

365-309-800 Lucent Technologies
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Installation Parameters

Northbound event nbgw
receiver. Values are

CIPC for QNN

interface; nbgw for

PRM interface.

Northbound er
notification server.

Values are CIPC for

QNN interface; er for

PRM interface.

Northbound response nbgw
manager. Values are

CIPC for QNN

interface; nbgw for

PRM interface.

A free-form field.
Installation procedures
should ensure that this
is set to the UNIX
host name of the
primary machine in
GR and ServiceGuard
machine sets.

NMS Port Selection n
screen enabled? Values
arey,n

Value of thread stack 128
size in kilobytes.

The location code /
delimiter (separates

the physical office
component from the

NE equipment address

in alocation code.

Is the PAMS interface | off
enabled? Values are
off, on

The name of the
PAMS account.



WaveStar TMS Parameter Table

PAMS_FILE_DIR

PAMS_PASSWORD

PAMS_SCHEDULE_AM

PAMS_SCHEDULE_PM

PCC

PM

PM_LOG_DIR
PM_LOG_WKSTN

PPALM

PP_COMBO_REST

PREEMPT

Lucent Technologies

The directory in which
PAMs auto-generated
files are placed.

The password for the
PAMS account (in
Clear).

The time (HH:MM)
scheduled for PAMS in
the morning, i.e.,
00:00 - 11:59.

The time (HH:MM)
scheduled for PAMS in
the evening, i.e.,

12:00 - 23:59.

Path continuity check
function enabled.
Values are off, on

Basic Performance
Monitoring (PM)
function enabled.
Values are off, on

PM remote directory

PM remote
workstation

To check if user wants
alarm triggered
preplan. Values are
YES, NO

Preplan combo flag.
Values are Y, N

Preemption function
enabled. Values are
off, on.

Installation Parameters

ITM_QA/PAMS_
NM

07:00

13:00

off

off

NO

off
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PRODSPLIT

PRODUCT

READ_ONLY_VIEWING_FOR_GD_USERS

REUSE_CLO_FOR_RS

RS

RS_SKIP_CHASS_VALID

RS_STOP_AT_LAY

RS_STOP_AT_TEST

365-309-800 Lucent Technologies
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Product ID for this JOINT_MULTI_
installation (Values are | ELS

NLS for R3T NLS

only, ELS for R3T

ELS only, JOINT for

joint R3T NLS and

ELS, JOINT_MULTI_

ELSfor one NLS to

many ELS, or

OTHER).

Name of the product. T30
Values are
T30,T30/VM, T30/JT

Geographic Domain FALSE
users may have a view

only for records not in

their domain.

Minimum value

FALSE; Maximum

value TRUE.

Reuse circuit order NO
data for restoration

circuits? Values are

YES, NO

Basic restoration off
function enabled.
Values are off, on

RS customer can N
choose to skip class
validation. Values are

Y, N

To determine if the Y
auto alarm triggered

RS order needs to be
stopped at LAY.

Values are Y, N

To determine if the N
user wants auto RS

stop at TEST step.

Values are Y, N.



WaveStar TMS Parameter Table

SAVE_DISC_WKLOG

SB_CORBA

SCHED_DISCONN

SPANISH

SWITCH_MSP

TANDEM_CONN

TELCO

TIMESLOT_FORMAT

TIM_PORT

TIM_TCP

TRENCH_ID_OPTION

Is archive of
Disconnect Orders
enabled? Values are Y,
N

Southbound CORBA
function enabled.
Values are off, on

Scheduled disconnect
function enabled.
Values are off, on

Spanish language
supported? Values are
on, off

Switch MSP function
enabled. Values are
off, on

Tandem connection
monitoring enabled.
Values are off, on

Name of the customer;
user to set other
parameters. Values are
BT-GTN, CHT, DTAG,
GCL, SDH

Timeslot format.
Values are G707,
SEQUENTIAL

Keep track of TIM
interface datakit port
address ( O if
TIM_TCPis“ Y”",
otherwise, user
supplied).

Keep track of TIM
interface network
type? Values are Y, “*

Trench ID usage is on
( TRUE) or ( FALSE)

Installation Parameters

on

off

off

off

off

SDH

G707

FALSE
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TWOBYTECHAR

UNALMUPP

UNASGN_SRVDOM_ON_DISC

WORD_IP_ADDRESS

To identify if it isa

double byte character
language. Values are
YES, NO

User notification of
alarms against unused
preplan functionality
enabled. Values are
off, on

To unassign channels
from service domain
when service is
disconnected. Values
are Y,N

IP address of DNA
serving Work Order
Record Documents
(WORDsS)

Installation Parameters

NO

off
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